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1 Introduction 

The Oasys Ltd LS-DYNA Environment 23.0 suite, dated Jun 2026, is a full release which 
supersedes all previous releases. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 22.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with Ansys LS-DYNA® releases 

The 23.0 release has been used and tested with Ansys LS-DYNA version R15. It supports all the 
keywords in volumes I, II and III of the released R15.0 User’s Manual (except ISPG). Some of 
the new keywords in the development R16 User’s Manual are also supported.  

Ansys LS-DYNA R11.0 is the default keyword output format of PRIMER. (However, output 
may be generated for later releases.) 

 

1.2 Hardware platforms supported 

Oasys Ltd LS-DYNA Environment 23.0 is available on the following platforms: 

Windows  Windows 11 64 bit 

Linux RedHat Enterprise 8.x 64 bit 

For Windows, v23.0 is built and tested on Windows 11. It should work on Windows 10, but this 
is untested. Windows 10 went end-of-life in October 2025, so you are encouraged to upgrade to 
Windows 11 if you currently use Windows 10. The software may also run on Windows 8.1, but 
this is untested. It will not run on Windows versions prior to that because of changes in the way 
Microsoft configure displays. 

For Linux, the RedHat Enterprise 8.x build has been released on the website as this has been 
found to run on all the Linux machines we have tested (RHEL 8, SuSE 15.3). If you require a 
different Linux build, please contact Support. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort. There are much better ‘thin wire’ graphics solutions 
available today. Please contact Support for more information. 
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1.4 Licensing 

This latest version of the software uses the LM-X licensing platform to provide an increased 
level of license security.  

To ensure you are ready to enjoy all the great features v23.0 will bring, we recommend you 
update all your Oasys Suite license servers and files as soon as possible.  

Action to take  

If you are using a floating network license, you will need to install the LM-X license server 
software (version 6.0.6). The software and supporting documentation are available to download 
from our website and are also included in our installation packages.  

Backwards compatibility  

The Oasys Suite 23.0 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 22.x, 21.x and 20.x 
software will continue to work with new LM-X license files and servers. 
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2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics. Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

Airbag 

• Case 58672 

After swapping SHELL topologies with their corresponding 
*AIRBAG_SHELL_REFERENCE_GEOMETRY topologies in PRIMER, a crash could be 
triggered when viewing the Xrefs of one of the affected Nodes. This has been fixed. 

Airbag Folding 

• Case 57346 

In the AIRBAGS folding panel some button text was truncated. This has been fixed by 
increasing the panel size. 

Attached 

• Case 56319 

Previously, the Attached tool, with the Recursive option set, could be very slow the first time it 
was run with a model containing many tied contacts. This has now been fixed such that the time 
taken to run the tool the first time is more consistent with subsequent runs of the tool. 

Belts 

• Case 58690 

The Forward/Backwards rotation for pelvis meshed sliprings was rotating the slipring in the 
incorrect direction during the fitting process when the orientation of the rotation vector was set 
based on the instructions in the help text and the configuration shown in the sketch but worked 
correctly when the rotation vector was reversed. 

This was due to the direction of rotation for both shoulder and pelvis meshed sliprings relying on 
a specific orientation of the rotation vector and the pelvis slipring rotation was incorrect if you 
specified the axis in the ‘expected’ direction. 

A fix has been made that ensures the slipring rotation for both shoulder and pelvis sliprings no 
longer depend on the orientation of the rotation vector defined in the ‘Slipring rotation’ panel. 

• Case 58689 

The belt path in the seatbelt fitting tool is split into segments at intermediate point of fixity type 
‘fixed’ or ‘slipring’. Therefore, if a path definition does not have any intermediate fixed/slipring 
points, it should only be composed of a single segment (bordered by the two end points). The 
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belt segment count calculation was incorrectly splitting the path into segments at end points set 
to ‘Fixed’ type, leading to an incorrect segment count. This has been fixed. 

• Case 58037 

Fixed an issue that caused the ‘Adjust’ option in the ‘Slipring rotation’ panel to reverse twist 
vectors for some belt path points under certain belt configurations. 

• Case 56982 

Fixed post-fitting belt path distortion near B-POST sliprings caused by discontinuities in belt 
width across different regions around the slipring. 

Cases 

• Case 58452 

ECER42 model build crash: 

ECER42 crash test setup could fail when block filenames started with a number during model 
build. This has been fixed. Filenames starting with a number are now blocked, and the error 
message has been clarified. 
 
ECER42 automatic part sets: 

ECER42 crash test setup could fail when using automatic part set options. Automatic part set 
setup is now supported and behaves consistently with other protocols. This issue has been fixed. 

Checking 

• Case 58644 

Fixed an issue where the check panel was unmapped when resetting or re-reading preferences 
while the panel was open. 

• Case 58240 

Previously, the model check tool would not report the error S_PT_130 (*SET_PART containing 
NRB is used by entity other than *LOAD_BODY_PARTS) if the referenced *SET_PART 
containing the NRB was referenced by both a *LOAD_BODY_PARTS and some other entity. 
This has now been fixed. 

• Case 58230 

Previously, the model check error code S_PT_130 (*SET_PART containing NRB is used by 
entity other than *LOAD_BODY_PARTS) was only reported as a warning despite the condition 
causing LS-DYNA to terminate. This has now been corrected: S_PT_130 is now reported as an 
error. 

• Case 58201 

A crash could occur when computing mass in a model containing tied contacts. This has now 
been fixed. 
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• Case 58130 

Previously, the model checker would report an error when a *PART containing BEAMs with 
ELFORM = 3 referred to a *MAT_NULL material. Furthermore, when creating or editing the 
*MATERIAL via the drop-down in the *PART edit panel, the *MATERIAL edit panel would 
not provide *MAT_NULL as an option when ‘Filtered’ mode was set. This condition is allowed 
in LS-DYNA and so the error has been removed along with the block to selecting *MAT_NULL 
in the editor. 

• Case 58104 

Previously, the model checker would incorrectly report that an invalid component type was used 
when the COMP field on a *SENSOR_DEFINE_ELEMENT(_SET) was set to ‘ZX’. This has 
been fixed such that the error is no longer thrown for this condition. 

• Case 56968 

Previously, the model checker did not report an error for when the OUTLV field on 
*EM_DATABASE_NODOUT was out of range. This has now been fixed. 

• Case 56912 

Previously, when a *COMMENT appeared prior to a keyword in a keyword deck PRIMER 
would incorrectly show that keyword as being referred to by the *COMMENT in the Xrefs 
panel. Furthermore, if the keyword was of an unlabelled type the model checker would report 
errors regarding an unlabelled type being referred to by another keyword. This has now been 
fixed. 

• Case 56170 

PRIMER will produce a model check warning when *NODEs are used by BEAMs or SHELLs 
referencing *MAT_NULL. However, this warning was not always thrown when it should have 
been, e.g. if the *NODE in question was also referenced by *ELEMENT_MASS. This has now 
been fixed. 

Comments 

• Case 51292 

Previously, if the special ‘$> end_saved_comments’ was manually deleted from an input file, 
and the lines that followed in the file contained PRIMER keyword header comments such as 

$ ========== 
$ NODE cards 
$ ========== 

PRIMER would save those comments. This has now been corrected such that these comments 
are no longer saved. 

Connections 

• Case 58880 

Some buttons for the PARMAX (MIG-weld) option on the Connection Options panel were not 
mapped correctly, e.g. missing. This has been fixed. 
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• Case 58507 

Creation of meshed in weld connections could leave unattached masses. These are now 
automatically deleted. 

• Case 58371 

Undo for Quick Pick of multiple *NODE labels was slow due to an un-necessary warning. This 
has been fixed. 

• Case 58085 

The Connection from FE tool, when applied to a NRB connecting three panels, now calculates 
the correct layers using NRB connectivity (i.e., AB:C or A:BC) where previously it did not. 

• Case 58046 

A model with highly ill-conditioned *MAT_100 SOLIDs could cause PRIMER to crash in the 
connection creation routine when running model checks or using the ‘Connections’ tool. 
Processing of such cases is now blocked to prevent the crash. 

• Case 57982 

Spotweld remeshing could take an unusually long time for some models. A significant amount of 
time was spent deleting failed spotwelds. To optimize performance, failed spotwelds are no 
longer stored during the remeshing process and are instead deleted at the end. This significantly 
reduces the overall remeshing time for full BIW models. 

• Case 57933 

When connections were deleted from the Connections Table with the ‘Leave FE’ option enabled, 
*SETs in the connection entity list were incorrectly emptied. This behaviour is only correct when 
the FE is deleted. This has now been fixed. 

• Case 57516 

Previously, PRIMER would not allow MIG welds to be applied to solid *PARTs. This has now 
been fixed such that they are allowed. 

• Case 57090 

Previously, screen picking of line welds has could be difficult. Screen picking has now been 
improved to make it easier to pick line welds. 

• Case 56642 

The option ‘modular bolts get unique deformable parts’ has been modified so that *SECTION 
and *MATERIAL cards are no longer duplicated. 

Constraints 

• Case 56719 

When adding or removing *NODEs in the Constrained Nodal Rigid Body edit panel, the master 
*NODE is automatically moved to the geometric centre (if applicable), and the NRB is redrawn. 
However, this was only being done when using the ‘Add nodes to NRB’ or ‘Rem nodes from 
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NRB’ buttons in the edit panel, and not when adding/removing *NODEs via the referenced 
*SET_NODE drop-down. This has now been fixed such that the master *NODE position is 
updated and the NRB redrawn when using either of these methods. 

Contacts 

• Case 58063 

*CONTACT_TIED_SURFACE_TO_SURFACE has been modified to ignore offset of either the 
tracked or master surface when section NLOC is set and CNTCO is set on 
*CONTROL_SHELL. *CONTACT_TIED_NODES_TO_SURFACE was correct. 

Contour 

• Case 57300 

Clicking ‘Update’ on the *LOAD_SHELL keyword editor would cause the model to switch 
automatically to SI display mode. This has been fixed with proper checks to see whether the 
current plotting mode is SI or CT and whether the contour data component is Shell normal 
before switching the display mode. 

Control 

• Case 58213 

Toggling of FORMING_AUTOPOSITION_PARAMETER or 
FORMING_PARAMETER_READ in the *CONTROL edit panel would produce “Unprocessed 
button id” errors. This has been fixed. 

Removed incorrect CONTROL prefix from the IMPLICIT_MODES button in the *CONTROL 
edit panel. 

Fixed toggle dependencies: 

− Turning off THERMAL_EIGENVALUE no longer disables THERMAL_SOLVER. 

− Turning off ICFD_OUTPUT_VAR no longer disables ICFD_OUTPUT. 

• Case 56683 

When two different *CONTROL Panels were open simultaneously and *CONTROL categories 
were selected, unprocessed button errors could occur. This has been fixed. 

• Case 56673 

When two different *CONTROL Panels were open simultaneously, and *CONTROL categories 
were selected then some cards overlapped. This has been fixed. 

Crash Test Setup 

• Case 57961 

Crash test setup panel would become modal after using sketching functionality, preventing 
access to other PRIMER options outside the panel. This has been fixed 
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Cut Section 

• Case 58426 

Whenever PRIMER was opened as a linked session from D3PLOT, 
the Cut Section panel would open automatically. This has been fixed. 

D3PLOT > PRIMER link 

• Case 56747 

Added a *d3plot file filter to allow files such as cpr_d3plot to now be recognized via the 
PRIMER-D3PLOT link. 

Deleting 

• Case 58218 

The displayed count of items (Models, Includes, or Assemblies) to be processed on the Cleanup 
panel has been corrected, as it could be incorrect when multiple models were in use. 

Dummies 

• Case 58882 

While creating an LS-DYNA analysis model for positioning Dummy/HBM, the Position menu 
was being unmapped. This has been fixed. 

• Case 57938 

Fixed an issue where the Replace Dummy Position dialog displayed the wrong position name in 
the confirmation message. 

• Case 57590 

Fixed auto-generated end position naming so that reused models continue with the next available 
suffix, avoiding duplicate PRIMER-generated end positions. 

Improved handling of duplicate saved dummy positions by introducing the 
dummy_overwrite_position_name preference with ALWAYS, ASK, and NEVER options. 
Updated replace position behaviour to resolve naming conflicts by retaining only the latest 
replacement and removing the original duplicate. This ensures consistent position naming and 
prevents ambiguity in subsequent dummy positioning operations. 

• Case 56276 

Removed unwanted widgets from the one-stage Dummy/HBM positioning panel. 

• Case 55224 

In the PRIMER Dummies/HBM positioning panel, new warnings have been added when STOP 
angles exceed the current assembly angles. 
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Edit 

• Case 58696 

The drop-down on the Part contents table was not working for IGSH and IGSO parts. This has 
been fixed. 

• Case 58017 

The scrollbar in the *AIRBAG_PARTICLE edit panel would previously jump to the top as soon 
as any fields in the open-ended region were edited. This has been fixed. 

• Case 41932 

The keyword *ICFD_DATABASE_POINTOUT did not have an editor. This has been fixed, and 
the Create/Modify editor is now available for this keyword. 

Elements 

• Case 58504 

LS-DYNA allows *ELEMENT_INERTIA with mass = 0 and simply adds in the inertia terms. 
PRIMER incorrectly blocked these terms. This has been fixed. 

Encryption 

• Case 57797 

Expanded Encryption Tool support for *DEFINE_FUNCTIONs. 

• Case 53374 

Fixed encryption key compatibility warnings for all key versions with newer LS-DYNA outputs. 

Error Trapping 

• Case 58242 

*DEFINE_CPM_GAS_PROPERTIES keyword will no longer incorrectly give a warning if PID 
is 0 in optional card 3. 

Frequency 

• Case 58186 

Previously, in the edit panel for 
*FREQUENCY_DOMAIN_RANDOM_VIBRATION_FATIGUE, the cards were not 
positioned in a way that matched the format of the keyword in the LS-DYNA manual. This has 
now been corrected such that the layout matches the format in the LS-DYNA manual. 

Previously, for *FREQUENCY_DOMAIN_RANDOM_VIBRATION, PRIMER would 
incorrectly always write a minimum of one card 5 and, if the _FATIGUE option was set, one 
card 7.1 even if NAPSD and NFTG were 0. Further to this, NFTG = -999 was not correctly 
handled. This has now been fixed.  
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General 

• Case 55044 

Fixed an issue where oa_pref failed to set background colours close to white due to RGB8 to 
RGB4 conversion. Background colours are now handled using RGB8 values. 

Geometry 

• Case 55250 

Previously, PRIMER would support the reading of PCURVE, 
DEFINITIONAL_REPRESENTATION, SURFACE_CURVE, or SEAM_CURVE entities when 
reading a STEP file. These STEP entity types, along with many others, are now supported. 

Graphics 

• Case 57557 

On desktops spanning multiple monitors, it is possible for the PRIMER window to occupy 
multiple screens, resulting in a graphics window resolution exceeding the existing 4096 x 4096 
pixel limit. This could cause a crash in some situations. 

This has been fixed by raising the limit to 65536 x 65536 pixels. 

• Case 56498 

Previously, PRIMER would miscalculate the bounding box for *GEOMETRY_ARCs, which 
could lead to inappropriate autoscaling. This was most prominent for arcs that had very large 
radii. This has now been fixed. 

• Case 47167 

True section display of BEAMs will no longer show overlay when global overlay mode is set to 
free edge or feature line. This can be activated in the Display Options panel under BEAMs or via 
a preference. 

• Case 17008 

Historically, PRIMER’s default graphics have drawn SHELLs on 3D element faces, i.e. co-
planar elements, at their true neutral axis meaning that such overlaid PARTs might show one 
element type or the other at random, and in some cases a mixture of elements. The exact 
rendering would depend on element topology order and the innards of the graphics card. 

For backwards compatibility this remains the default case, but there is now a Display Option to 
‘Lift’ co-planar SHELLs above the SOLID faces which, in most cases, means that only the 
SHELLs are drawn. 

Related to this, screen-picking of elements had a slight bias towards SHELLs in this situation but 
could quite often pick up the SOLID element instead. This has now been improved so that: 

− In cases where screen-picking could legitimately select different element types, for 
example when picking a PART, it will now always select the SHELL rather than the co-
planar SOLID face. This is the case regardless of whether SHELL graphics have been 
raised as explained above. 
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− In cases where an explicit element type is being picked then that type will be pickable 
‘through’ its co-planar alternative element types, even if it is visually obscured by them. 
In particular, it is possible to pick a SOLID face obscured by a SHELL element which 
shares the same nodes. 

This picking bias in favour of SHELLs is not switchable. 

Groups 

• Case 55566 

Fixed a bug where duplicate ANSA comment entities were created for models with INCLUDEs 
and when include files were added to a model. 

IGA 

• Case 58536 

Running contact analysis, performing checks, or using the contact keyword editor could result in 
a crash when *IGA elements were included in the contact. This has been fixed. 

Include 

• Case 57282 

When using the ‘add new child’ function to add a model with INCLUDEs, the process works 
through model merge. Subsequent ‘Find modified’ operations incorrectly flagged the entire 
model. This has been corrected to flag only the includes added to the target model. 

Include Transform 

• Case 58127 

Previously, PRIMER would fail to apply label transformations from an 
*INCLUDE_TRANSFORM to all labels referenced in an IF(a1,a2,a3,a4) statement in a 
*DEFINE_CURVE_FUNCTION. This has now been fixed. 

Integration 

• Case 58620 

PRIMER did not always find D3PLOT results files in the Post menu if it was open when a model 
was read. This has been fixed. 

• Case 58614 

Fixed an issue where adding a model via ‘Add to PRIMER’ in D3PLOT caused inconsistent 
views between PRIMER and D3PLOT due to view resynchronization. 

• Case 58364 

The crash handler in Oasys Ltd codes allows configuration settings to be saved in oa_pref files 
across Home, OA_INSTALL, and OA_ADMIN directories. 
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Previously, no checks were performed to determine whether OA_INSTALL or OA_ADMIN 
directories were write-protected, allowing you to attempt to save settings that would fail. This 
has been fixed: if these directories are defined but write-protected, the option to save to them is 
now disabled (greyed out). 

• Case 56290 

Previously, PRIMER only picked up *.ptf, *.d3plot, and d3plot files automatically for the 
D3PLOT link. This issue has been fixed. Now, other valid files (d3eigv, d3part, d3ssd, *.fz, 
*.ctf, etc.) will also be picked up automatically. 

JavaScript API 

• Case 58107 

The length of names for Windows, Widgets, and WidgetItems in the GUI Builder was previously 
limited to 50 characters. This restriction has been removed. 

• Case 57280 

LSTC Dummy Conversion tool: 

Fixed an issue where reading a keyword file with data after %endoccinfo would result in the tool 
throwing an error. 

Fixed an issue where reading an unsupported file caused the tool to throw an error. 

If an invalid LCS is read, the tool now uses the H-point (if available) instead of defaulting to (0, 
0, 0). 

• Case 57140 

The Sensor class constructor could fail if the SENSOR label clashed with an existing 
*SENSOR_SWITCH_SHELL_TO_VENT that could be relabelled. This has been fixed. 

• Case 57078 

Previously, looping through thousands of Database History Beams to simply update their 
properties could be very slow. This has been improved. 

• Case 56162 

If a script contained an error in a callback function PRIMER would not throw an exception, 
causing the script to become unresponsive. This has been fixed. 

Keyword 

• Case 56821 

Previously, for *CONTROL_ACCURACY, PRIMER would report an error stating that IACC 
was out of range when the value was set to -1. This has now been fixed such that -1 is allowed. 

• Case 56538 

OPTT for *CONTACT_AUTOMATIC_NODES_TO_SURFACE has been corrected to only set 
the thickness for SURFB as per the latest LS-DYNA manual. 
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• Case 54691 

For *INITIAL_VELOCITY_GENERATION, STYP=0 was allowed which was causing issues. 
Now, neither the keyword editor nor the edit panel allows STYP=0. Also, the default value is set 
to 2. 

• Case 43227 

Keywords *EM_DATABASE_ELOUT, *EM_DATABASE_NODOUT, and 
*EM_DATABASE_POINTOUT did not have editors. This has been fixed and Create/Modify 
editors are now available for these keywords. 

Keyword Editor 

• Case 58094 

Drop-down menus were missing for the LARGE and ILOCAL fields in the 
*INITIAL_STRAIN_SHELL and the UNIT field in *INITIAL_IMPULSE_MINE editors. These 
have now been added. 

• Case 57974 

Previously, the edit panels for *INITIAL_STRESS/STRAIN_TSHELL did not work when the 
suffix was set to ‘none’. This has now been fixed. 

• Case 57351 

Some keyword edit panels in PRIMER have large radio button boxes on the side. Depending on 
the values of the initial numbers of keyword definitions and rows (settable via the Menu panel 
configuration panel, or the primer*kw_edit_init_defs and primer*kw_edit_init_rows 
preferences), this can result in a large amount of grey space below the keyword definitions in the 
keyword edit panels. To correct this, by ensuring enough rows/definitions are displayed to fill 
the panel, the initial numbers of keyword definitions and rows can now be set to ‘AUTO’, either 
by setting the corresponding preference(s) to ‘AUTO’ or by toggling the ‘Auto’ button in the 
Menu panel configuration panel. Provided that at least one of these values is set to AUTO and 
neither of them have a numerical value set the number of keyword rows and definitions drawn 
will be such that they fill the keyword edit panel. 

• Case 55049 

Previously, the title of the *DEFORMABLE_TO_RIGID keyword editor was incorrect. This has 
now been fixed. 

Licensing 

• Case 57029 

The (optional) ‘timeouts’ functionality, which suspends a session if it has been idle for longer 
than a specified time, was not working correctly in PRIMER. 

This was due to changes in licence management which caused internal confusion about what was 
being measured. This has been fixed. 
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Mass 

• Case 57969 

PRIMER previously did not calculate the speed of sound, and therefore the timestep, correctly 
for elements using *MAT_280 (*MAT_GLASS). This has been fixed. 

• Case 57558 

In the Assign Mass tool when applying mass to PARTs using subsets, empty PARTs in the 
subset are now ignored rather than triggering an unnecessary error. 

• Case 56696 

Previously in PRIMER, in the Mass Properties panel, if the Inertia Properties was set to ‘Centre 
user defined’ and then ‘Rigid elems’ was selected, then the Inertia Properties would be switched 
back to ‘Centre at CofG’. This has been fixed. 

Materials 

• Case 56782 

Previously, PRIMER would not the angle of the material triad to the ztf file correctly. This has 
now been fixed. When there is beta angle on the material card (MAT34, etc), this will be the sum 
of that and the angle on the section card. 

Mechanism 

• Case 57547 

Previously, PRIMER would allow the creation of mechanism positions with duplicate names. 
Handling of duplicate saved mechanism positions names has been improved by introducing the 
‘mechanism_overwrite_position_name’ preference with ALWAYS, ASK, and NEVER options. 
Updated replace position behaviour to resolve title conflicts by keeping only the latest 
replacement and removing the original duplicate. This ensures consistent mechanism position 
naming and avoids ambiguity during subsequent mechanism positioning operations. 

• Case 57031 

Hinge mechanisms where the points are too close with respect to the size of the mechanism 
assemblies can be unstable. A new check warns of this and, before positioning, offers you the 
option to extend the hinge size. 

Menus 

• Case 58563 

When PRIMER calculates the optimum size of menu panels, it considers their contents but 
previously did not account for the text in the panel title. In rare cases, when the title was long and 
the panel contents was narrow, the panel could be truncated. 

This has been corrected so that the title pane and its buttons are now included in the panel size 
calculation. 
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• Case 58553 

In Tools → Other → Forming, clicking the label for the ‘Interpolate thickness’ checkbox 
previously caused the panel to close. This has been fixed. Clicking the label now correctly 
toggles the checkbox on and off. 

• Case 55691 

Previously, in the Menu Attributes panel the selected Dynamic viewing was not highlighted in 
the Presets popup list, making it difficult to recognise which option was selected. This has now 
been fixed. 

• Case 52826 

Fixed a *CONTROL panel resize issue where *CONTROL categories overlapped selected 
*CONTROL cards. 

Merge 

• Case 56706 

Node merge tolerance was previously set automatically to 0.1 or 1e-4 based on model units, 
which could override user-defined settings. 

Automatic setting is no longer applied if a user-defined tolerance is specified. 

If the input exceeds 0.9 × characteristic element length, a warning is issued, but the merge is still 
applied. 

Mesh 

• Case 58462 

Fixed UI update issues for the New Solids dropdown in Solid Extrude mode and the New Beams 
dropdown in Nodes Extrude mode. 

Fixed an issue in Node Extrude where the ‘Start at’ label value was not updating. 

• Case 58047 

Previously, clicking the ‘Reject’ button in the Mesh Geometry panel would return to the 
Vertex/Join selection step as intended but would incorrectly deselect all surfaces, forcing you to 
restart the whole process. This has now been fixed. 

• Case 56715 

When creating SPH mesh elements inside a volume, the volume was previously required to be 
closed. PRIMER can now create SPH elements in volumes with holes or small gaps between 
parts. 

• Case 55873 

Previously, the SPH meshing script created SPH shells when internal horizontal shells were 
present. This has been fixed. 
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• Case 33217 

Fixed an issue in Shell Split with Line – Multiple, where dot-sketching of selected SHELLs was 
lost after clicking “Draw Line.” The sketching is now displayed correctly. 

Model Build 

• Case 57238 

Missing and extraneous ZCOORD headers printed out in list file for MODEL BUILD have now 
been fixed. 

− For the GENERAL_PARAMETER_TRANSLATE list file output: A user-defined 
ZCOORD header was missing after the user-defined YCOORD, and a calculated 
ZCOORD header was incorrectly added after the remaining headers, causing 
misalignment. This has been corrected so that headers align with the appropriate 
columns. 

− For PEDLEG_UPPER_2 list file output: An extra ZCOORD header was incorrectly 
added after the remaining headers. This has been removed. 

Model Modified 

• Case 58251 

Previously, when performing a Model modified operation, if a keyword had character string data 
that had changed the information window outlining the differences could truncate the message, 
leading to some data differences disappearing from the message. This has been fixed such that 
Model modified reports for character string differences are now done using 2 separate lines. 

Parameter 

• Case 57789 

Added an option in the keyword i/o panel to control renaming of duplicate *INCLUDE file 
names. 
Added an option when writing keyword files to supress writing special comment ‘tags’ for 
mutable parameters. 

• Case 57108 

Editing a parameter from the Part Tree, Contents, or List menu appeared to accept changes, but 
these were lost after updating. 

This was caused by an internal error and has been fixed. 

• Case 41797 

PRIMER, when it reads in a model, can sort out *PARAMETER references that precede the 
corresponding definitions. As a result, it previously did not issue errors for these out-of-order 
situations. 

This behaviour has been modified. PRIMER now reports errors for such cases during model 
checks. As mentioned, PRIMER will sort these out internally and will write out the definitions 
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before any references during model write. Therefore, a model write operation will cause 
PRIMER to suppress these errors for the appropriate model(s). 

Part Table 

• Case 57080 

Lumped mass distributed to part only considered parts of type Shell, Solid, Tshell, Beam. Mass 
on NRB was transferred to these parts. Now parts of type Discrete, Seatbelt and (D)Sph will 
keep mass that attaches to them. This does not change the global mass calculation for a model. 

• Case 56922 

Updated handling of the option ‘IFLAG’ in *CONSTRAINED_EXTRA_NODE and 
*CONSTRAINED_RIGID_BODIES so that COMPONENT_MASS in the part table more 
accurately reflects mass transfer to PART_INERTIA. 

• Case 55613 

Previously, if you made the Transparency column visible in the Part Compare table, then closed 
and reopened the panel, the column settings would be reset; however, the Transparency column 
would remain displayed, and everything would get in a muddle until you toggled the column on 
again. This would happen with a few other columns. This has been fixed. 

Part Replace 

• Case 57942 

Previously, performing a Part Replace with a source *PART that did not have a material or 
section definition PRIMER would create a *SECTION with 0 thickness in the target model. This 
has been fixed such that the missing *SECTION is now applied in the target model. 

Part Tree 

• Case 57241 

Resolved an issue where *MATERIAL keywords were not grouped under a single branch in the 
part tree contents. 

Pedestrian 

• Case 57798 

Previously, when running the GB24550 2024 protocol in the Pedestrian Markup tool, the corner 
bumper plate written to the debug model could have different dimensions to those specified by 
the protocol (236mm x 236mm). This was to demonstrate the space that the plate, of correct 
dimensions, could occupy within which the corner bumper point was still valid. However, to 
improve clarity, the debug model now contains both the correctly sized Corner Bumper Plate and 
its ‘Valid Range’ counterpart. 
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• Case 57314 

The Pedestrian Markup tool could be slow, particularly when computing the position of the 
semi-circular template used to join the side reference line with the bonnet rear and windscreen 
rear reference lines. This has been improved and is now 5–10× faster. 

• Case 54694 

As part of the EuroNCAP and CNCAP protocols, when marking the WAD lines on a vehicle, 
should the WAD lines end in a gap in the outer contour of the vehicle (such as between the 
bonnet rear and windscreen) the outer contour of the vehicle should be approximated 
horizontally rearward of the last contact point with the vehicle, the end point of the WAD line 
should be found on this tape and then projected vertically to the underlying structure. Previously, 
the Pedestrian Markup tool was approximating the outer contour of the vehicle as described but 
was not projecting the point to the underlying structure. This has now been corrected such that 
the tool performs this projection. 

However, for the front of the vehicle, between the lower bumper reference line and bonnet 
leading edge, the protocol states that the outer contour of the vehicle should be approximated 
with tape and that points should be marked on this tape. As it is not clear from the documentation 
whether the projection should still occur at the front of the vehicle, the projection step at the 
front of the vehicle has been made user controllable (accessible through the WAD menu, or via 
the ‘project_front_wad’ command line option). This option is turned off by default. 

Preferences 

• Case 56557 

Previously, some options available in the Display Options and Orient Options panels were not 
being saved as preferences after clicking the ‘Save display settings’ and ‘Save Orient settings’ 
buttons respectively. This has been fixed with the addition of the following preferences for 
PRIMER: 

- back_faces 

- internal_faces 

- li_hi_free_edges 

- use_triad_minimum 

- triad_minimum_factor 

- use_triad_scale 

- triad_scale_factor 

- shells_use_optt_sft 

- swap_nodal_coords_mode 

- swap_shell_topology_mode 

- display_model_name_option 

- copy_orient_options_labels 

- orient_general_label 
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- orient_node_el_label 

Fixed write_hm_comments. 

Program Crash 

• Case 58670 

Fixed a crash caused by repeated right-clicks on Timesteps in the Dyna output tree viewer. 

• Case 58040 

The combination of *COMMENT and *AIRBAG_CPG in an input deck could cause a crash 
when opening the *AIRBAG_CPG editor. This has been fixed. 

• Case 58025 

Using Node Replace with Auto enabled, which updates the model immediately, could cause a 
crash during node picking. 

This occurred because the picking mechanism was not aware of changes in the node count, 
leading to potential instability. A workaround was to disable Auto or turn off parallelised 
picking. 

This has been fixed. 

• Case 57956 

Resolved a potential crash that could occur during node dragging when multiple models were 
open. Additional validation checks have been implemented to improve stability and help prevent 
similar crashes. 

• Case 57955 

Resolved a potential crash that could occur during the hole removal operation. Additional 
validation checks have been implemented to improve stability and help prevent similar crashes. 

Quick Pick 

• Case 58515 

Resolved an issue where, after performing ‘Node → Modify → Pick a node on screen → Sketch 
node → Close panel’, subsequent screen picking of *NODEs was disabled. 

Read 

• Case 58080 

When Text Edit is used to process unlabelled items, for example *INITIAL, *LOAD and a few 
*CONSTRAINED cards, PRIMER needs to know which internal definition is to be modified 
when it rereads the edited file. To make this possible it adds $PR_EDIT_INFO comments which 
identify the internal label and include file id. 

If such a definition is manually cut and pasted into a full keyword file, leaving the comment 
(which says ‘Do not edit or delete’, so this is likely to happen) it causes problems when read into 
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PRIMER as a normal keyword input deck since the $PR_EDIT_INFO comment can change the 
current *INCLUDE file. This can result in items read from *INCLUDE file A being placed in 
incorrect *INCLUDE file B. 

This has been fixed. $PR_EDIT_INFO comments will now only be processed during keyword 
input if this is part of a Text Edit operation, in all other contexts these comments will be ignored. 

• Case 57096 

Reading models containing large amounts of encrypted data from a remote machine took a long 
time. This has been fixed. 

A new preference, ‘keyin_temp_file_location’, now allows you to control where the skipped 
PGP data file is written. The default value is AUTOMATIC, which writes the file to the local 
temporary directory when the top level keyword file is located on a remote machine. 

Renumber 

• Case 58348 

PRIMER could crash or corrupt data if the Model→Renumber→Visualise panel was used in 
Include mode and ‘only’ was used on one of the blocks in the ‘ALL’ row. This has been fixed. 

Scripting 

• Case 58606 

Fixed a crash that could occur when rescaling the PRIMER window when running the HRMD 
script. 

• Case 57769 

Previously, when importing custom sliding plane in the Luggage Retention tool, if the 2D plane 
was already at a certain angle, the tool would incorrectly position the blocks without making 
proper contact. The tool now accounts for the initial angle and places the blocks correctly. 
Additionally, another option (relative/absolute) is provided while giving the angle input to 
account for the initial angle of the plane. 

• Case 57188 

The simulation end time and control parameters will now always be prioritized from the 
HPM/HRMD (Human Model) *CONTROL card when merging with a vehicle model, previously 
this was not the case. 

• Case 56674 

When using the HPM tool, the H-point shown after positioning did not always match the final 
seated position. It is now correctly updated at the end of the positioning process, ensuring the 
displayed H-point reflects the final seat location. This has been fixed. 

• Case 55755 

Resolved an issue where running the HPM/HRMD tool multiple times in the same session could 
exhaust available flagging bits. 
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The logic for recycling flags has been corrected to ensure stability during repeated execution. 

Selection 

• Case 58608 

Polygon selection - and other selection modes such as screen area and screen circle - could, 
previously fail to complete if a dynamic view change occurred during selection. This could 
happen before completing the polygon or, for rubberband selections (click, drag, release), before 
releasing the mouse button. This has been fixed. 

• Case 58027 

Previously, when using Vis → Area or All_Vis in an object menu, PRIMER would allow the 
selection *MASS_PART or *DATABSE entities even if their visibility was turned off in the 
Entities panel. These items reference visible *ELEMENTs or *NODEs but are not in themselves 
visible, so are now excluded. 

• Case 56753 

Path selection for SHELLs did not work in the PART → Remove Elements menu. This has been 
fixed. 

• Case 53021 

Improved path line selection for triad SHELLs via PRIMER object menus. 

Sets 

• Case 58210 

Previously, PRIMER could hang when updating a *SET_type_ADD with a recursive reference 
to itself. The UPDATE button in the *SET edit panel is now disabled in these cases. 

• Case 58056 

Added support for *SET_XXX_GENERAL content operations using SET/DSET options. 
PRIMER supports only simple list-type sub-sets. 

Sketch 

• Case 58294 

When creating multiple *NODEs (e.g., Node → Create → Between 2 points), some hardware 
did not sketch all created *NODEs until the plot was refreshed, requiring a graphics flush to 
display pending output. This was more likely when predictive picking, which updates the screen 
following significant mouse movement, was disabled. 

This has been fixed. 
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SPH 

• Case 57792 

Hover text has been added and updated for all inputs in the SPH mesh tool. A link to the new 
manual page has also been added. 

Spotwelding 

• Case 58313 

On the connection table, use of update and remake via the drop-down for meshed-in welds is 
now consistent with remake all/selected in terms of running the logic to re-attach items to the re-
meshed area (this logic was previously missing for the former case). 

T/HIS > PRIMER link 

• Case 57227 

Fixed an issue where an extra point was created when transferring curves to T/HIS prior to 
clicking Create. 

Transform 

• Case 58720 

Edit → Update on *INCLUDE_TRANSFORM within *INCLUDE_TRANSFORM, where 
labels are offset, applied an incorrect offset to TRANID. This has been fixed. 

User Interface 

• Case 58015 

The Material Create Panel has been redesigned for MAT_ADD_ keywords. 

• Case 57846 

Node set text box headers have been changed to grey, rather than colour-coordinated with the 
corresponding diagrams. This prevents inconsistencies between UI themes. Diagrams have been 
updated with extra labels and colour-coordination removed, to match these updates. 

• Case 56788 

The job monitor window, used to monitor the progress of LS-DYNA jobs submitted from 
PRIMER, was originally programmed to remain ‘in front’ of other windows. 

This behaviour has been modified so that the window now follows the same stacking order as 
other windows in the PRIMER main window. 
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Volume III 

• Case 56682 

Field MID in *EM_EP_CELLMODEL_USERMAT was previously, incorrectly, treated as the 
label of the *EM_EP_CELLMODEL_USERMAT. This has been fixed such that it is now 
treated as MID in *MAT. 

Workflows 

• Case 58227 

Previously, reading older user data JSON files with fewer components was not supported. This 
has been fixed such that these files can be read, even if new components have been added in later 
releases for the same entity. 

Write 

• Case 58721 

The workflow definition filename written to the workflow user data file could incorrectly use the 
$HOME variable instead of $OA_WORKFLOW. This has been fixed. 

• Case 57092 

Segment sets can now be written with explicit zeroes for a1..a4 instead of blanks. In LS-DYNA, 
zero or blank values use the default options d1..d4. Other software may require explicit zeroes. 

XRef 

• Case 58173 

Edit for *DAMPING via the cross-reference tree was incorrectly showing the create 
*DAMPING panel. This has been changed to show the keyword editor for *DAMPING. 

ZTF 

• Case 58298 

Writing a ZTF file in batch (command line ‘-d=batch -ztf=input.key’) could cause a crash if 
operations were being logged in the LMX licence log file. 

This occurred because writing the ZTF file in this mode does not require a licence, so no 
connection is made to the LMX licence server, and attempts to write to its log file would fail. 
This has been fixed by detecting this situation and not writing anything. 

• Case 56274 

D3PLOT previously did not appear to draw *CONSTRAINED_NODAL_RIGID_BODY cards 
correctly if any associated *NODEs had the _MERGE keyword option assigned (i.e., node 
merges were specified). This has been fixed. 

PRIMER now accounts for these merges when writing ZTF files, allowing D3PLOT to correctly 
render *CONSTRAINED_NODAL_RIGID_BODY definitions.  



Oasys Ltd LS-DYNA Environment Release Notes 

Version 23.0 
 

          Jun 2026  

 

Page 24 
 

2.2 D3PLOT 

Annotation 

• Case 58624 

Annotations with multiple models in a window would sometimes not reload animation settings 
correctly and this could cause D3PLOT to crash and D3PLOT Viewer export to write invalid 
files. This has been fixed. 

Component 

• Case 57996 

Beam parts contoured with *MATERIAL_HISTORIES components could be incorrectly 
contoured with zero values rather than shown with N/C. This has been fixed. 

Contour 

• Case 58075 

If a 2nd model was opened in D3PLOT while the 1st was displaying a CPG based data 
component, then when a contour plot was generated for the 2nd model, the data component 
would be correctly displayed as the same CPG component being displayed on the first window, 
but all the contour values would be set to N/A as though no data was available. This has been 
fixed. 

• Case 57937 

When an entity is not associated with a selected component and that entity is set to shaded mode, 
doing a CL/ISO plot does not retain the shaded plot on that entity. This is fixed. 

• Case 56761 

Contour did not auto refresh when using Annotations with envelopes in HDF5 files. This is now 
fixed. 

• Case 56649 

For some components like SHELL_THICKNESS the data at state 0 is not initialised and this 
gives wrong results when used state 0 as ref state in Tools → Deform → Ref state. In such cases 
state 1 can be used as ref state as they can also be used as undeformed state. 

As a fix for data component SHELL_THICKNESS, when you select ‘Use undef (#0)’, a 
message pops up saying the ref state is set as state 1 and explaining why this happens (this 
message only appears for the first time). 

• Case 56599 

If nodal data components were being contoured and a cut section was active, then the min/max 
data values reported on the screen were not very accurate as they only considered nodes that lied 
exactly on the cutting plane. 
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In D3PLOT 23.0, all nodes on the cut elements are now used to calculate and report the min/max 
values. 

Cut Section 

• Case 58688 

If while in the cut section menu you were selecting parts to exclude from the cut section and 
temporarily went into a different menu and then repressed the ‘Cut Sections’ button, the part 
selection menu was remapped but selecting and deselecting parts in it did not work correctly. 
This has been fixed. 

• Case 56470 

When the cut section panel was opened multiple times in the same D3PLOT session, it always 
showed the direction tab D1 even if a different tab was selected previously. 

Now it still shows D1 when first opened in a session. When D2 or D3 is selected on the cut 
section panel, then some other menus are opened and then the cut section panel is opened again, 
it shows the same direction tab as previously selected, which is not necessarily D1. This new 
behaviour is more consistent with PRIMER. 

Deform 

• Case 57727 

When plotting user-defined component with reference state from a different model, data could be 
incorrectly calculated. This has been fixed. 

Dialogue Command 

• Case 58450 

Dialogue command for blanking x-sections is now updated to ‘x-sections’ from previously ‘x-
section’ in D3PLOT. 

• Case 58370 

When using command history in the dialogue window (via Up/Down Arrows), strings on the 
dialogue window could become corrupted. This has now been fixed. 

• Case 58202 

D3PLOT incorrectly flagged the dialogue command ‘BP_BEAM_PLOTTING’ as invalid, but 
accepted ‘BP’, ‘BP_BEAM’ and ‘BP_BEAM_PLOT’ as acceptable alternatives. This has been 
corrected so the full command is now also deemed valid. 

• Case 58139 

When D3PLOT was open with a linked T/HIS session and in the D3PLOT dialogue box /THF 
MENU_SKETCH M1 was entered without entity type or label, then sometimes D3PLOT 
crashed. Now it will ask for ‘type’ ‘label’ after only the model has been specified. 
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When the dialogue commands /THF LOCATE_ITEM, SKETCH_ITEM or DISPLAY_ITEM 
was specified without model number on the same line, it was incorrectly treated as 
MENU_SKETCH. This has been fixed. 

When the model number for any of these commands was specified with entity type name, for 
example NODE, then there was a false error message ‘Illegal character or construction’ but the 
command worked fine. Now the error no longer appears when the syntax is correct. 

• Case 57932 

Reloading a REPORTER D3PLOT item with /STATE LAST in a command file would not 
correctly set the reloaded model to the last state if the reload model had more states than the 
model that the item was captured from. This has been fixed. 

• Case 57186 

If the command line is used to select a user defined ‘OTHER’ component there was no way to 
set the correct entity type that the component applied to. In D3PLOT 23.0, you are now 
prompted for the entity type you want to apply the component to. 

• Case 57136 

When setting the overlay colour of entities with the dialogue command 
/PROPERTIES OC_OVERLAY_COLOUR 
to DEFAULT, they got the same overlay colour as they have got as ordinary colour. Some of 
you expected to get the same colour as is used by default for the overlay, which is set in the 
Display options panel and will be grey by default. 
 
The dialogue command option DEFAULT in this option has now got the alternative name 
ENTITY because this is how the equivalent button on quick pick overlay colour popups is 
called. To set the colour defined in Display options there is now a new option CURRENT for the 
colour. 

Envelope 

• Case 54768 

Envelope data calculation in D3PLOT has been speeded up as it is now parallelised. 

Filename 

• Case 57765 

Giving relative path for the models in the session file will not work properly as it always 
considered the path relative to the current working directory. 

This has been corrected by considering the path relative to the path of the session file itself for 
the models in the session file. 
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Graphics 

• Case 58345 

When on the Data menu the data plot refresh option Contours was ticked and then the number of 
contour levels was changed, the data plot did not always update immediately. When the new 
number of contours was typed in at the top of the Data menu, the refresh worked as expected. 
However, when the slider in the contour options tab was used, the refresh did not happen. 

Now the plot refreshes after both ways of changing the number of contours. 

• Case 58191 

If some CPG particles were hidden using the options in the Display menu to only show particles 
with a subset of boundary types Autoscale still included the hidden CPG particles when scaling 
the view. This has been fixed. 

• Case 57971 

If you tried to screen pick nodes on a solid PART by dragging out an area, D3PLOT would only 
pick the nodes on the external faces of the solids while PRIMER would also select the internal 
face nodes. 

In D3PLOT 23.0, this has been changed so that by default D3PLOT will now pick the nodes on 
internal faces as well. This behaviour can be turned off if required via the ‘Options > Pick & 
Select opts’ menu by turning off the option to pick ‘Internal Items’ 

• Case 57774 

If a model contained a large number of SPH, ABP or CPG particles then the graphics window 
could flicker if a cut section was turned on and you were interactively dragging the cut section to 
reposition it. This has been fixed. 

• Case 31922 

Autoscale used to leave more white spaces in some models when the view was not aligned with 
global coordinates. This is now fixed and it fits the visible model tighter. 

Groups 

• Case 58038 

D3PLOT could crash if you tried to create groups in D3PLOT for a mode that contained LOAD 
definitions. This has been fixed. 

JavaScript API 

• Case 58872 

Component.BV, Component.CV, Component.DV, Component.VV, Component.AV, 
Component.RDV, Component.RVV, Component.RAV, Component.TFV were all unavailable to 
JS API QueryDataPresent(), this has now been fixed. 
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• Case 58856 

Fixed a crash when trying to use GetData()/GetMultipleData() for use with a JavaScript UBIN 
U_SOSH components for specific Layer integration points. 

• Case 58723 

When the JS API function Part.Elements was called on a part whose element type had not got a 
JS API class, for example for the part of SPH elements, then D3PLOT crashed. Now the script 
reports an exception in that situation. 

• Case 58119 

The JS API function Pick() on the global class now returns null instead of an exception when the 
picking is cancelled. This has already been the case for the Pick() functions on classes like 
Node.Pick(), Part.Pick() etc. This functionality for the global Pick() function allows to handle the 
cancellation in scripts also for entity types which have not got their own classes in the D3PLOT 
JS API. 

• Case 58084 

The special memory comment at the top of a script would be ignored when running a script if 
another script was already running. Now fixed. 

• Case 57999 

When in a D3PLOT object in REPORTER a JavaScript was defined with lines longer than 512 
characters, they were truncated and could cause errors while generating. This included cases 
where REPORTER variables are used in the script and then the lines exceeded the length after 
inserting the variable values. This limit has now been increased to 1024. 

• Case 57817 

When getting the ‘material’ property in the JS API classes Beam, Part, Segment, Shell, Solid or 
Tshell in a model written directly as d3plot/.ptf from PRIMER, there was an exception in 
D3PLOT. Now the property will be null in those cases, which gives more options for scripts to 
handle this situation. 

• Case 57603 

The JS API function IsDeleted returned false for the type_code Type.PART even when all 
elements were deleted at the state specified. This has now been fixed. 

• Case 57281 

When any data component was plotted and the contour range option ‘Auto each frame’ was 
selected with envelope plotting on, then the Max: and Min: values shown on the model in the 
graphics area were for the current state only. Now they are the correct maximum and minimum 
of the values after enveloping. 

• Case 57046 

When there are multiple models in a window and then the model which the window was first 
created with is removed from that window, any JavaScript or Python GraphicsWindow objects 
pointing to that window became invalid. Now they continue to point to the same window. 
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• Case 56675 

The JS API function GetConditionParts gave unexpected results with nodal data components like 
displacements, velocities or accelerations. This has now been fixed. 

• Case 56638 

The JS API function Part.Blanked sometimes returned unexpected values for spring or seatbelt 
parts after the shortcut key “r” was pressed. This has now been fixed. 

• Case 55267 

The JS API function GetConditionParts did not support spotweld data components 
Component.SW_F, Component.SW_FAIL, Component.SW_S etc. Now this function adds a part 
to pass_list for spotweld components if there is at least one beam or solid spotweld with 
underlying element in the given part such that the data value of the spotweld satisfies the 
condition specified. 

Labels 

• Case 56650 

Element triads or local X, Y, Z could previously already be drawn using either a fixed size or 
using automatic size computation. A new scale factor has now been introduced for use with the 
automatic mode which will allow you to increase or decrease the symbol size as per their 
requirements. 

Load Paths 

• Case 58810 

The Fixed radius option in the display options for load path symbols in D3PLOT was set to 15.0, 
which meant that sometimes the load path symbols could cover the model, this is now sorted. 
The load path symbols fixed radius is now 1% of model size by default, you can change the 
value if you choose. 

Measure 

• Case 58070 

If the ‘m’ shortcut key was pressed to use measure for the 1st time in a D3PLOT session while a 
data component read from the LSDA (BINOUT or D3DAT) was being plotted, D3PLOT would 
crash. This has been fixed. 

Multiple Models 

• Case 57076 

When D3PLOT was opened with the command line argument -ml=... to specify a model list file, 
sometimes the models were not opened in the correct windows. This happened and has been 
fixed in the following circumstances: 
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When model M1 is specified to open in window W1 (1 in the file) and model M2 in window W2 
(2 in the file), the models opened as expected, but model M2 appeared twice in window W2. 
This could be seen by M2 appearing twice at the top left of the graphics window. Also, the 
‘models’ property on a JS API GraphicsWindow object for that window counted the model 
twice. 

When models were opened in reverse order, for example model M1 requested to open in window 
W2 and model M2 requested to open in window W1, model M1 could actually end up in 
window W1 too. 

When there were gaps in the windows specified, for example only in windows W1, W3 and W4 
but nothing in W2, then D3PLOT could crash. Now it opens the models requested for W3 in W2 
and those requested for W4 in W3 in this situation, so it condenses down the window numbers. 

Nastran 

• Case 58667 

D3PLOT would crash if a model was read in from a OP2 file and then the PTF Compress utility 
was used to generate a set of cut-down d3plot/PTF files for the model. This has been fixed. 

Program Crash 

• Case 57934 

When applying a settings file that plots a contour plot on one model with a reference state from 
another model D3PLOT could crash. This has been fixed. 

• Case 57159 

When trying to read the model using the -ml command line argument and the path of model is 
provided into double quotes (invalid format), then D3PLOT trying to read the models gets 
crashed. 

This is fixed. Now when there is no valid model name in the model list file given in -ml, 
D3PLOT throws an error and prompts new model read via the ‘OPEN PLOT FILE’ menu. 

Properties 

• Case 58494 

If a properties file was read in for a model which contained SPH elements, the blanking status 
was not always applied correctly for some of the SPH elements. This has been fixed. 

Python API 

• Case 58833 

The Python API function Part.Elements sometimes reported an exception even when all 
arguments were correct. This has now been fixed. 



Oasys Ltd LS-DYNA Environment Release Notes 

Version 23.0 
 

          Jun 2026  

 

Page 31 
 

• Case 58045 

When a Python script called Oasys.D3PLOT.Measure.GetFromID and then tried to access 
properties of the Measure object returned, there were unexpected errors. This has now been 
fixed. 

Quick Pick 

• Case 58603 

An extra line, ‘Main file : <Unknown>‘, was being displayed in the Part Information box during 
Quick Pick. This issue has been fixed now. 

• Case 58460 

The picking of spotwelds that are drawn as spheres has been improved so that the radius of the 
sphere is now considered along with the z depth when considering if a spotweld is hidden behind 
another element. Previously just the centre of the spotweld was used. 

Read 

• Case 58676 

D3PLOT was crashing when tried to select the models from the popup in the Models list during 
reading settings file through ‘File → Open new model → Settings file including window layout’ 
read mode. 

Also, when the models were first loaded followed by selecting the settings file here would throw 
errors for models which are already loaded in the memory when pressed ‘Apply’. 
This is now fixed. 

• Case 58581 

Typing settings filename in the textbox in the OPEN PLOT FILE menu always throws an error 
saying non existing filename. 
This is now fixed. 

Settings File 

• Case 53847 

Cut sections defined with constant X, Y or Z with a node or 3 nodes with with ‘origin follows 
node’ off could change location when reloaded from settings files. This happened when after 
first creating the cut section the state was changed so that the defining nodes moved with the 
plane remaining at the previous location. 

This has been fixed and D3PLOT loads the cut section at the location determined by the nodes at 
the state where it was done before saving the settings file. 
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User Interface 

• Case 58589 

After displaying the transient message of ‘Multiple ZTF files found...’ in the OPEN PLOT FILE 
window, the button label flickered between ‘(Re)Read’ and ‘Apply’ when the mouse was 
hovered over it. This issue has been fixed now. 

• Case 58438 

If annotations was selected as the output option in the D3PLOT Viewer tab of the Images panel 
then all annotations were deleted. The Images panel would change the output option to current 
page, but the current frame / animation radio button would not be visible. This has been fixed. 

Write 

• Case 57548 

When we write out Yield Utilisation Percentage using WRITE Table in D3PLOT, we get N/A 
instead of the data values. This is now fixed. 
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2.3 T/HIS 

Airbag 

• Case 58519 

For a CPM airbag the Y-axis units for the ‘MAF’ and ‘MAV’ data components were not set 
correctly to ‘Mass’. This is fixed now. 

Blanking 

• Case 57941 

Auto Blank by ‘Entity ID’ for airbag part data auto blanked by part ID instead of airbag ID. This 
is fixed now. 

Curve Table 

• Case 57171 

In a linked D3PLOT- T/HIS session, a scroll bar would appear in the Graph buttons tab of the 
Curve table even when there were not enough graphs to require one. This is fixed now. 

Curves 

• Case 57790 

The smoothing factor is now correctly displayed in the History data. Previously, the value shown 
reflected the half-window rather than the total window. This issue has been resolved. 

Data Components 

• Case 58113 

T/HIS 23.0 supports the following new LS-DYNA R17 CPG airbag data components 

− Part heat convection 

− Part heat convection rate 

− Part energy leakage 

− Part energy leakage rate 

Datum 

• Case 58501 

The datum points stored in session file (or fast-tcf file) are truncated to 6 decimal places, so if the 
datum points values are less than E-06 the datum is not re-drawn with precision when retrieved 
the session (or re-run the fast-tcf). This is now fixed. 
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FAST-TCF 

• Case 58692 

T/HIS can now sum operate on more than 1024 curves when outputting through ISO-MME. 

• Case 58138 

The command to extract airbag cpg part data, e.g. 
ab_cpg_pa 10001 4 spr tag SPR_P## lab Pressure P## 
tagged all the curves with SPR_P10001, i.e. it substituted the ## with the airbag ID. In this case 
it should substitute it with the part IDs, i.e. SPR_P4, SPR_P5 etc. This is fixed now. 

• Case 58129 

T/HIS wrote the wrong Fast-TCF command for curves generated using the Octave operation. 

If the Octave operation used the ‘1/3 Octave Bands’ option T/HIS wrote the Fast-TCF command: 

operation octave curve_1 octave mean linear 

The second ‘octave’ should have been ‘third’. Similarly, if the ‘Octave Bands’ option was used 
T/HIS wrote: 

operation octave curve_1 third mean linear 

Where ‘third’ should have been ‘octave’. 

This has been corrected. 

• Case 57632 

Reading multiple models now updates all the T/HIS menu pathnames to the directory from 
which the models were read. Previously default paths were install directory. This is fixed now. 

Filename 

• Case 58661 

In Image write, the filename that gets into the recent files was updated to next filename instead 
of the current filename. This is now fixed. 

Also, when typed in the image output file the extension was not appended to the filename and 
eventually the image file gets written without the extension. This is fixed. 

• Case 55227 

The Curve Table in T/HIS now supports saving data in CSV and XLSX formats, along with files 
using custom extensions. When a filename is entered without an extension, the system 
automatically applies either a .csv or .xlsx extension to ensure proper file creation. 
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Generate 

• Case 54046 

When capturing a FAST-TCF where a docked Legend’s position had been altered, that 
information was not being retained. This meant on reading of that FAST-TCF, the legend would 
be positioned automatically via T/HIS. We now remember what position the legend has been 
altered to and now regenerate the graph with that position. 

Graphs 

• Case 58687 

Turning off the y2-axis from the floating menu of a graph did not work. This is fixed now. 

• Case 58074 

When loading a second model containing airbag cpg data in T/HIS using ‘Extract curves to 
match model’, T/HIS would crash. This is fixed now. 

• Case 58065 

Toggling y-axis to logarithmic will cause a crash when the minimum positive value of the axis is 
smaller than the minimum value that is representable by a float. This has been fixed. 

• Case 57754 

The JS API function Graph.GetFromID can now support more than 32 Graphs. 

• Case 56721 

After turning off the graph legend area, it was not always possible to reposition the bottom of the 
graph by dragging the bottom axis. This is fixed now. 

Integration 

• Case 58162 

In T/HIS linked to REPORTER, if you click on the scrollbar in the ‘Active window:’ popup then 
the active window selection would not work correctly and could cause a crash. This has been 
fixed. 

• Case 58155 

With T/HIS linked to REPORTER, if you click on the ‘New Graph’ button in the REPORTER 
panel while other graphs were open and contained curves, T/HIS could crash. This has been 
fixed. 

• Case 58050 

In the REPORTER panel, if more than 6 graphs are open in the session graph selection is via a 
popup list, selection on this list did not work. This has been fixed. 



Oasys Ltd LS-DYNA Environment Release Notes 

Version 23.0 
 

          Jun 2026  

 

Page 36 
 

JavaScript API 

• Case 58517 

If you try to set a non-existent page as an active page through JavaScript, T/HIS used to stop 
executing the script with an error saying, ‘Error executing the script’. It has been now corrected 
to give an error message in the dialogue box that the page does not exist and continues to execute 
the remaining script. 

• Case 56713 

CORA now truncates ref and sim curves to the overlapping range with evaluation intervals set to 
‘full’. Previously, Y_NORM (peak absolute value of the reference curve) was calculated before 
truncating curves to the overlapping range. This could result in some confusion if the reference 
(test) data had a peak value before/after the start/end of the simulation curve data. 

Multiple Models 

• Case 58073 

Opening multiple models that contained airbag CPG data previously caused T/HIS to crash. This 
is fixed now. 

Operations 

• Case 58470 

Updating the curve history of a curve read from ISO-MME data and labelled with the channel 
code would revert the label to the channel code. This has been fixed. 

• Case 58126 

The history curve menu did not always show the correct constant values used in an operation in 
the hover text or in the popup menu to change the values. Additionally, it was not possible to 
change the values to 0. This has been fixed. 

• Case 58016 

The dialogue command to do a regression operation (‘operate > regr’) could get stuck in a loop if 
an invalid option was selected. This has been fixed. 
 
Right clicking on a curve generated by this operation and selecting the History menu could cause 
a crash when hovering over the Regression button or when right clicking on it. This has been 
fixed. 

• Case 57297 

T/HIS now resets the injury properties when you manually edit a HIC curve using the edit panel. 

• Case 55841 

T/HIS can now do the Max, Min and Envelope operations with non-monotonic curves. 
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PDF 

• Case 58537 

When using a Datum defined via points and capturing an image of a graph with 2x or 4x screen 
resolution, the image would appear disjointed. This has been fixed. 

Pages 

• Case 57533 

If graph(s) were deleted using a JavaScript while T/HIS was open in the link with D3PLOT the 
page layout would not be updated following deletion, leaving empty spaces on the page. This has 
been fixed. 

Preferences 

• Case 58757 

When using preferences y_grid_spacing_auto, x_grid_spacing_auto, x_axis_type and 
y_axis_type without their intended input strings, unintended values for graph properties were set. 
This has now been fixed. 

Read 

• Case 58847 

When trying to read a .DAT file via the DIAdem reading routines when the .DAT file was not a 
valid DIAdem file, T/HIS would crash. This has now been fixed. 

• Case 57514 

When the ISO codes in an .iso file are not in proper format (only the first letter should be capital) 
T/HIS was not reading in the iso file. 
This has been fixed. 

Session 

• Case 58714 

‘Extract curves to match model’ did not work when reading a model into T/HIS that has a 
session file already loaded. This is fixed now. 

• Case 58469 

When trying to overwrite an existing session file, T/HIS automatically created a new session file 
with the next available number series. 

Now giving the same session name highlights the text box in red, and when clicked Apply, it 
gives an option to ‘Overwrite’ the existing session file or create a ‘New file’ which updates the 
textbox with new filename with next available number series. 
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• Case 58420 

When loading a session file for a linked D3PLOT-T/HIS session error messages ‘Error in 
FTCF_ADDITIONAL, model ID (n) not used’ could be printed to the T/HIS command window. 
This has been fixed. 

• Case 57951 

When attempting to retrieve a T/HIS session file which was created from a T/HIS instance where 
a session file had been retrieved with embedded curve files, T/HIS could report an error and be 
unable to read the session file. This has been fixed. 

• Case 57035 

If multiple session files were read in one after another and the option to append new 
graphs/pages that the session creates to those already in T/HIS then the page layout of new pages 
was not set correctly. This is fixed now. 

• Case 56967 

T/HIS could crash if multiple session files were reloaded one after the other and you tried to start 
the 2nd (or subsequent) reload before the previous one had completed. In T/HIS 23.0, the menu 
has been modified to inhibit the start of a 2nd restore session while another one is still being 
processed. 

T/HIS Link 

• Case 58505 

When reading T/HIS files, if a directory named ‘D3PLOT’ was present, T/HIS incorrectly 
assumed it to be a valid d3plot file and attempted to read it as a d3plot/PTF file. This resulted in 
an error because the path referred to a directory rather than a file. 

T/HIS has now been updated to distinguish between files and directories and will attempt to read 
a d3plot only when the path corresponds to a valid file. 

Variables 

• Case 54531 

You can now choose what text should be replaced by a variable in REPORTER FAST-TCF 
script item. 

Workflows 

• Case 58646 

With the removal of the 32 graph and 32 page limits in standalone T/HIS, but not in linked 
T/HIS, JS API functions Page.MaxAllowable() and Graph.MaxAllowable() have been added. 
These return the maximum allowable number of pages / graphs. 
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• Case 55445 

In the Automotive Assessment workflow, the curve colours used for structural assessments 
would depend on the number of structures selected and were not always consistent. This has 
been fixed. 

Write 

• Case 58677 

In T/HIS, when operations are defined using an ISO MME JSON file, the system previously 
determined the operation output curve dimensions based on the results of the curve calculations. 
With the recent change, T/HIS now reports the curve dimensions derived directly from the ISO 
code, rather than those computed from the curve calculations. 

• Case 58582 

On the T/HIS Write Panel the Apply button did not work if an error (such as a writing read-only 
file or incorrect folder) occurred in the textbox. Now you can change file name and save file if 
they mistakenly put in wrong file name. 

• Case 58406 

Typing a filename without extension into the Write Menu output box and pressing Apply will 
now automatically add the extension to the filename and write out the file. 
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2.4 REPORTER 

Filename 

• Case 57379 

When a D3PLOT item had got Image file paths containing spaces, they were being trimmed. 
This has been fixed. 

Integration 

• Case 58052 

Settings files for components in the Material Properties category were not correctly reloaded (the 
contours often appeared as N/C). This has been fixed. 

• Case 57759 

Fixed an issue where newly created D3PLOT items attempted to load a default auto-generated 
job file path that did not exist, causing unwanted D3PLOT information popups. D3PLOT now 
opens with the File Open dialog when the job is invalid, providing a better user experience. 

PDF 

• Case 58524 

The image on the master page is now written only once per PDF output to reduce the output PDF 
file size. 

• Case 58476 

Fixed the issue of fonts not being displayed inside the table cell when the descent height is 0 

Program Crash 

• Case 58223 

Fixed a REPORTER crash that occurs when trying to generate templates with a large number of 
pages. 

• Case 57954 

REPORTER will no longer crash when trying to insert Library Program items inside a table 
item. 

Tables 

• Case 58609 

Table misalignment could occur in some library templates when viewed in REPORTER and 
REPORT Viewer. This issue has now been resolved. 
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User Interface 

• Case 58288 

The coloured tiles hover box in the preference dialog for colours now has contrasting text and 
background colours for better readability. 

• Case 57461 

Icons in the Line Style combo box were too small, making it difficult to identify each style. This 
has been resolved. 

User Defined 

• Case 58577 

When a template was opened via command line, sometimes the page thumbnail did not update. 
This has been fixed. 

Workflows 

• Case 56797 

The MPDB Compatibility calculation did not work correctly if the model used a unit system that 
did not use mm. This has been corrected. 

• Case 56532 

The Automotive Assessment workflow would crash for the MPDB compatibility load case if the 
barrier was not aligned with the global X or Y axis. This has been fixed. 

2.5 SHELL 

User Interface 

• Case 58862 

Enhanced REPORTER Variables Panel – improved usability with a fix to the scrollbar 
behaviour, ensuring smoother navigation and consistent movement. 

• Case 57825 

On Linux, the ‘Oasys Ltd LS-DYNA Environment’ message at the bottom of the main shell 
window could be cut off vertically. 

This was due to a positioning error that only showed up on Linux, now fixed. 
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2.6 Oasys Suite – Cross Application 

Integration 

• Case 57778 

If T/HIS was launched from REPORTER and a further model was opened in T/HIS with the 
‘extract curves to match model’ option ticked, then the curves would not be created correctly. 
This has been fixed. 

JavaScript API 

• Case 57838 

If the background or foreground colour of a widget was set with Colour.RGB() in the GUI 
Builder and then saved to a .jsi file, the values got saved and loading the .jsi file read the values, 
but the widget colour did not get updated. The same was true of the window background colour. 
This has been fixed. 

Menus 

• Case 55846 

On some occasions, the software might ignore the ‘stop’ button or other buttons which control 
the progress of dynamic operations, such as during seatbelt fitting, unless pressed multiple times. 

This was caused by how button press events were processed during active operations. This has 
been recoded to make it more robust, fixing the problem. 

Python API 

• Case 58386 

Fixed broken links in the Python PDF manual that prevented downloading files and accessing 
the Python documentation. 

T/HIS link 

• Case 58067 

In a D3PLOT and T/HIS linked session, selecting an entity in the T/HIS panel could sometimes 
open the Help box unexpectedly. This is now fixed. 

Workflows 

• Case 55916 

Workflows were not sorted alphabetically. This has been fixed and workflows are now listed in 
alphabetical order. 
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3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics. Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

Ale or Euler 

• Case 55025 

Added support for drawing and sketching colours for the following ALE keywords 
*ALE_COUPLING_NODAL_CONSTRAINT, *ALE_COUPLING_NODAL_DRAG, 
*ALE_COUPLING_NODAL_PENALTY and *ALE_STRUCTURED_FSI. 

Attached 

• Case 56338 

An option to specify a fixed number of iterations for Find Attached Recursive has been added. If 
left at zero, the original fast iteration will be applied until all items are found or timeout is 
reached. 

• Case 50445 

Find Attached with tied contact option on and recursion was analysing all tied contacts up front. 
When attached was performed on only a subset of the model, this incurred considerable 
redundant calculation of contacts. The method has been changed so contacts are now analysed on 
moving front as they appear in the current visible volume. 

Belts 

• Case 55860 

Seatbelt fitting tool: Added an option to auto-refine the belt mesh at the region around meshed 
sliprings when using the ‘Adjust’ feature from the ‘Slipring rotation’ panel. 

• Case 53010 

Added an option to auto-rotate 2D sliprings during the fitting process to a more natural position 
based on the iterative position of the incoming and outgoing belt sections. 

• Case 44548 

You can use the new ISOFIX tool in PRIMER to build ISOFIX load case models for ECE R14. 
It automates common setup tasks such as importing and positioning the SFAD model, creating 
constraints and contact definitions, and applying inertial loading. It writes keyword models to 
your chosen output folder using your selected keyword version. 
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Checking 

• Case 57926 

The checking report on *INITIAL for duplicate items has been improved to enable easier 
deletion of superseded definitions on the assumption that the final (highest internal label) 
definition wins. 

• Case 56973 

PRIMER can output the results of model checks as a text file and can also write these results to 
an output model keyword file. In both instances, the version of PRIMER that was used for 
checking is now also written out. 

• Case 56481 

A warning is given if DT2MS on *CONTROL_TIMESTEP is greater than zero as this is likely 
to have unintended consequences. For models with seatbelt elements, an error is reported (as 
before). 

Connections 

• Case 56914 

MIG welds can now be made at a defined pitch rather than being fixed onto edge nodes. 

• Case 56830 

Creation of MIG/ARC welds from IGES curves has been substantially improved. 

• Case 56775 

PRIMER now supports the import and export of connection data from and to standalone files in 
the χMCF format. 
 
Additionally, connection data embedded as post-*END χMCF by some software can now also be 
read in and processed by PRIMER during model input. 

• Case 56751 

A preference, primer*connection_arcweld_method, has been added to support 
TIED_CONTACT or NODAL_RIGID_BODY 

Constraints 

• Case 57853 

When ‘Only’ is applied on the edit panel of *CONSTRAINED_EXTRA_NODE, PRIMER 
previously displayed only the constrained nodes. PRIMER now also displays the PID (*PART or 
nodal rigid body) as well. 
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Contour 

• Case 57254 

Thick Shells can now be contoured depending on their normal (away: blue; towards: magenta). 
Previously, this was only possible for thin shells. 

Crash Test Setup 

• Case 57752 

You can now set up the C-NCAP Frontal Impact MPDB protocol in Crash Test Setup. The test is 
included in the crash test library and can be selected directly from the Crash Test tab. 

• Case 57178 

You can now set up the C-NCAP Side Impact MDB protocol in Crash Test Setup. The test is 
included in the crash test library and can be selected directly from the Crash Test tab. 

• Case 57177 

You can now set up the C-NCAP Side Pole Impact protocol in Crash Test Setup. The test is 
included in the crash test library and can be selected directly from the Crash Test tab 

• Case 57176 

You can now set up the C-NCAP Front Full Width Frontal Impact protocol in Crash Test Setup. 
The test is included in the crash test library and can be selected directly from the Crash Test tab 

• Case 51298 

Added a preference to select Absolute or Relative file path in the ‘Write Master File’ Window. 

• Case 50992 

You can now run Crash Test Setup in PRIMER batch mode using batch XML configuration and 
your saved preferences. This enables automated setup of crash test cases from the command line 
without a graphical interface, allowing you to process multiple test setups efficiently. 

• Case 49574 

Modified the UI for the ‘Preferences Panel’ and ‘Keyword Link Panel’ in Crash Test Setup. 

Cut Section 

• Case 57093 

The Cut Section Custom Spacing panel did not allow you to have less than two plane positions. 
As the local cut origin 0.0 is always present, when there was only one other plane position this 
could not be deleted. Also, the number of parallel planes could not be set to 1. The reason for 
this behaviour was because a plane only at 0.0 has the same effect as turning multiple cuts off. 

This behaviour turned out to be inconvenient when it is exactly known what plane positions are 
wanted and all previous ones were unwanted. 
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Now PRIMER allows to delete all positions except for 0.0 and there is also a new button ‘Clear 
positions’ to delete all positions except 0.0. 

Deleting 

• Case 56010 

Added Ctrl+Z as a shortcut for UNDO in PRIMER. 

Dummies 

• Case 55678 

A script has been written to write out element quality metrics. It can be accessed from: 

1. Node import process 

2. Main JavaScript menu 

3. Tools → Element quality reporting 

The script can write output in two formats: 

1. Euro NCAP HBM CP 551 Frontal_VTC 

2. IIHS Rear Impact SIMULATION Data Submission Template 

The script can write output to a new file or to an existing Excel file. 

Edit 

• Case 43684 

Historically, the ‘generic’ editor, the editor which mimics the exact keyword format for 
individual keywords, has not had popups giving the options for integer fields. (e.g., 1 = part id, 2 
= part set id) 

These popups were not always present in ‘keyword’ (multi row) editors as well. 

These are now enabled in generic editors and the missing fields in keyword editors, although the 
implementation of this will be gradual since the popup data has to be created for all keywords 
and at the time of writing only some have been done. 

Element Quality 

• Case 52494 

You can now perform an element quality check on just the visible elements of a model. 

Geometry 

• Case 58072 

The layout of the select Join and Vertex options, in the Mesh Geometry tool, has been improved. 
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• Case 52267 

As part of increased support for CAD file formats, PRIMER can now read CATIA V5 files. 

Graphics 

• Case 57585 

Added *IGA_1D_BREP sizing to the model size calculation. This means that the geometry of 
these entities can affect view autoscaling. 

• Case 57579 

Added *IGA_EDGE_UVW sizing to the model size calculation. This means that the geometry 
of these entities can affect view autoscaling. 

JavaScript API 

• Case 58203 

For the CrossSection class, the radius has been added as an optional argument to the constructor. 

• Case 57567 

Added generic functions such as Blanking, Drawing, Sketching and Picking to all eligible *IGA 
JS classes. 

• Case 57540 

Added a JS API and a PY API class for the *IGA_REFINE_SOLID keyword. 

• Case 57030 

The Error and Warning methods were missing from the History class. They have now been 
implemented. 

• Case 42398 

Autofixes can now be given for custom (JavaScript) checks. 

Keyword 

• Case 57983 

Post-end Altair HM UDM xml can now be read/written by PRIMER with support for part label 
change. 

• Case 57939 

Added generic editors for *CHEMISTRY_CONTROL keywords. 

• Case 57848 

Scalar editors are now available for the following keywords: 

− *CHEMISTRY_COMPOSITION 
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− *CHEMISTRY_DET_INITIATION 

− *CHEMISTRY_INFLATOR_PROPERTIES 

− *CHEMISTRY_MODEL 

− *CHEMISTRY_PATH 

− *CHEMISTRY_PROPELLANT_PROPERTIES 

• Case 57187 

Added editors for the following keywords: 

− *STOCHASTIC_SPRAY_PARTICLES 

− *STOCHASTIC_TBX_PARTICLES 

− *LSO_DOMAIN 

− *LSO_ID_SET 

− *LSO_POINT_SET 

− *LSO_TIME_SEQUENCE 

− *LSO_VARIABLE_GROUP 

• Case 48616 

Added a dropdown menu for the field FLOW_VAR in *DUALCESE_D3PLOT. 

Keyword Editor 

• Case 57574 

Added the scalar and keyword editors for the *CESE_INITIAL_<OPTION> keyword. 

Load Paths 

• Case 57990 

Load path tool ‘Auto-create’ feature: Added an option to split each cross-section plane into four 
separate *DATABASE_CROSS_SECTION definitions. 

• Case 57989 

Load path tool ‘Auto-create’ feature: Added an option to create cross-sections along splines 
instead of linear segments between selected nodes, using arc-length-based positioning and 
orientation. 

• Case 57988 

Added an option to encode cross-section location into IDs using the format 
[root][coord][sign/quadrant], with clash detection and automatic range resolution strategies. 
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Loadcurves 

• Case 56717 

A syntax checker has been added for *DEFINE_CURVE_FUNCTION. 

Manual 

• Case 51105 

Added a ‘k’ button on the right side of *CONTROL categories, which opens the respective 
keyword manual. 

Mass 

• Case 53008 

You can now write out an .xlsx file containing the assign mass data of selected assign mass 
entities from your model, including thumbnails of the corresponding entities. Preferences have 
been added to control the output data and images. 

Measure 

• Case 54460 

A new Measure tool has been added to calculate the radius of a hole from three nodes. 

• Case 33897 

Added multi-measure capability as per D3PLOT. 

Menus 

• Case 50715 

Go To Label and Go To String search functionality is now available for all object menus: 

− Go To String scrolls the menu to the first item that contains or matches the input string. 

− Go To Label scrolls to the item whose label most closely matches the user-entered label. 

• Case 37043 

Previously, the CREATE/MODIFY DEFINE_FUNCTION panel displayed 10 rows regardless 
of panel size. The number of rows now adjusts dynamically with panel height. 

Mesh 

• Case 58099 

Fixed an issue in the Mesh Geometry tool where surface selections were not preserved when 
toggling the “Join Surfaces” option ON/OFF. PRIMER now retains the selected surfaces during 
this operation. 
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• Case 58098 

Fixed an issue where PRIMER could crash when using the Mesh Geometry tool if the element 
size was changed multiple times while previewing the mesh on selected model surfaces. 

• Case 58004 

Previously, when generating Tet mesh for a volume, PRIMER created tetrahedral elements of 
almost the same size at both the surface and within the interior. In cases where the focus is 
primarily on surface behaviour, larger elements in the interior can help reduce computational 
cost. 

To support this, depth-based sizing parameters have been added, and the Tet mesh panel has 
been updated to allow elements to grow towards the interior of the volume. 

Model Build 

• Case 56311 

You can now resize the first column in the Template Control Panel when the panel is expanded, 
making it easier to view long names. 

Model Modified 

• Case 53895 

When the Model Modified panel is dismissed, the Modified tab is no longer tidied. 

Part Replace 

• Case 37291 

An option has been added to ‘abort out’ of a Part replace operation either at the merge stage or at 
the end of the operation. This option restores the original model. 

Pedestrian 

• Case 57131 

When writing out Lines and Test Field boundaries in the Pedestrian Markup tool, the file 
containing the line for the side of the bumper test zone has been renamed from BUMPER_END 
to BUMPER_SIDE. 

• Case 57048 

In the Pedestrian Markup tool, when writing out impact points to CSV files, the tool only writes 
z-coordinates for points that fall in the gaps of the outer contour of the vehicle or points that have 
been projected horizontally. The option to always write z-coordinates for all head impact points 
has been added, which can be found in the new ‘Output options’ menu, accessible from the Head 
impact points menu. 
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• Case 56339 

A new preference, primer*model_build_lst_decimal_places, has been added, which allows you 
to limit the number of decimal places in .lst files. 

• Case 53209 

A new preference, primer*pm_beam_length, has been added which allows you to set ‘Beam 
length’ in the Pedestrian markup tool. 

Properties 

• Case 54382 

You can now efficiently copy properties from one model to multiple others simultaneously, 
without the need to manually write out and re-read files. 

Quick Pick 

• Case 57865 

Added picking functionality for *IGA_FACE_XYZ. 

Scripting 

• Case 57992 

Improved error handling for the Luggage retention tool and introduced stricter checks for user 
input. 

• Case 57017 

SBA Automation tool: 

Added an option to squash seat using PRIMER. 

Added an option to align lap block along a user-defined vector N1N2. 

Moving torso block close to seat back and added an option to keep the block at a user-defined 
distance from the seat back. 

If the torso block, after being moved, penetrates the lap block it will be translated away from the 
seat back until the penetration is resolved. Alternatively, you can specify an offset distance to 
eliminate the penetration. 

Torso block is now adjusted so that its loading belt aligns with the lap block’s belt 

Added a right-side mount type seat option for the middle seat in second row. 

• Case 56950 

A new testing protocol, ‘EuroNCAP Front FWDB (2026)’, has been added to the Crash test 
setup. 
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• Case 56899 

Luggage Retention Tool: 

Added view planes at H-point, H+100, and H+150. 

Added an option to position the luggage floor at a user-defined height. 

Added an option to rotate the luggage floor downward by a user-defined angle. 

Speed 

• Case 58102 

Historically, using bespoke editing panels to Create or Modify items caused them to be sketched 
when the Update action was applied. For large items such as *SET and *CONTACT, this could 
be slow in large models. 

An option, ‘Sketch item on Edit update’, has now been added to the [DISPLAY] Sketch options 
panel to enable or disable this behaviour. This setting can be saved as a preference. 

Text 

• Case 56493 

The contents of the dialogue box can now be saved as a text file using the new Save → Text 
option. 

User Interface 

• Case 55981 

In the Graticule Display Options Panel, empty space has been removed for the 2D option as the 
space was used by buttons and textboxes only mapped for 3D option. 

• Case 53723 

Increased the maximum number of rows in ‘CONNECTION TABLE’, ‘CONX COMPARE’, 
‘PART TABLE’, and ‘PART COMPARE’ panels from 50 to 100 to account for larger screen 
sizes. 
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3.2 D3PLOT 

Cut Section 

• Case 57094 

The cut section custom spacing panel did not allow to have less than two plane positions. As the 
local cut origin 0.0 is always present, when there was only one other plane position, this could 
not be deleted. Also, the number of parallel planes could not be set to 1. The reason for this 
behaviour was because a plane only at 0.0 has the same effect as turning multiple cuts off. 

This behaviour turned out to be inconvenient when it is exactly known what plane positions are 
wanted and all previous ones were unwanted. 

Now D3PLOT allows you to delete all positions except for 0.0 and there is also a new button 
‘Clear positions’ to delete all positions except 0.0. 

FEMZIP 

• Case 57794 

D3PLOT 23.0 supports reading of Set Part Trees for FEMZIP files using the latest femzip dlls. 

Graphics 

• Case 38620 

D3PLOT now has a new RendPh plotting mode that enables photo-realistic graphics with 
support for environment maps. Create high-fidelity, presentation-ready visuals in real time with 
realistic materials, reflections, and environment mapping. 

JavaScript API 

• Case 57527 

There is now a new function Page.Current to return a JS Page object for the page currently 
selected in D3PLOT. 

• Case 57231 

There are now JS and Python API constants: 

− Constant.MAX_ALL 

− Constant.MIN_ALL 

− Constant.MAG_ALL 

− Constant.AVERAGE 

They can be used for the ip option on Beam.GetData, Shell.GetData, Tshell.GetData and 
GetMultipleData on the same classes. These functions then return the maximum, minimum, 
maximum magnitude value or average across all integration points. 
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• Case 57169 

On the JS API Measure constructor node1, node2, node3, part1, part2 and window should now 
be specified as Node, Part or GraphicsWindow objects. The previous syntax with positive 
indices or negative labels for nodes or parts still works for backwards compatibility, but it has 
been deprecated. 

The new syntax is more consistent with other object-oriented JS API functions. Moreover, it 
should avoid confusion between indices starting at 0 and indices starting at 1. 

• Case 56676 

There is now a JS and Python API function Part.GetConditionParts doing the same thing as the 
previous JS GetConditionParts on the global class but returning arrays of Part objects instead of 
arrays of indices starting at 1. 

The indices starting at 1 caused confusion because Part.GetFromIndex was called on them, and 
the latter function expects indices starting at 0. The return array with Part objects avoids such 
confusion. 

• Case 56635 

There are now properties ‘colour’, ‘transparency’, ‘displayMode’, ‘overlayColour’ and 
‘overlayMode’ on the JS API and Python classes Beam, Contact, Node, Part, Segment, Shell, 
Solid and Tshell for the display options of these items. 

• Case 49552 

In JavaScript there can now be a callback function defined to be called whenever the state in 
D3PLOT changes interactively. For example, when a script opens a GUI window, that callback 
can be used to update any buttons depending on interactive state changes. 

Materials 

• Case 42213 

D3PLOT can now write and retrieve render material properties using XML file format. 

Part Tree 

• Case 56563 

Set Part Trees are now supported in D3PLOT. We can populate Set Part Trees from ptf/d3plot 
file output of Ansys LS-DYNA. We can interact with the Set Part Trees using the Part Tree 
menu and Quick Pick menu in D3PLOT. All the options that work for Includes and Part 
Assemblies in part tree also work for Set Part Trees in D3PLOT.  

Python API 

• Case 55002 

There is now a new JS and Python API CutSection class. 
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Text 

• Case 56494 

The contents of the dialogue box can now be saved as text file with a new button Save → Text. 

Workflows 

• Case 52730 

New Adhesive Utilisation workflow available to contour adhesive utilisation/ plastic strain from 
a contour scale of 0-2. There are multiple options for you to show contour results that are 
suitable for adhesives, and eroded elements can also be displayed. 

• Case 50852 

New Adhesive Utilisation and Fastener/Spotweld Utilisation workflows are now added. These 
Utilisation workflows are built upon and replace the existing Strength Check workflow. You can 
now use these tools to contour adhesive and fastener/spotweld utilisation, with non-adhesive and 
fastener/spotwelds being blanked or shown shaded with transparency. Eroded adhesive and 
fastener/spotweld elements can also be displayed. 

• Case 50841 

Strength Check workflow has been replaced by General Utilisation workflow. This allows you to 
easily show and contour parts with plastic strains above a user-specified amount. 
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3.3 T/HIS 

Airbag 

• Case 58060 

T/HIS now supports the new BINOUT data component ‘Unblocked Part Area’ that LS-DYNA 
now writes for CPG airbags. 

Graphs 

• Case 45810 

Maximum number of graphs and pages in T/HIS are both increased from 32 to 1024. T/HIS will 
now allocate additional memory for graphs and pages beyond 32, as long as the system allows. 

Also increased the absolute maximum number of graphs on a single page from 32 to 64, though 
the default remains at 32 out-of-the box. This setting can be changed interactively on the Page 
Layout panel or set via a preference. 

Pages are no longer added and deleted by adding graphs to or removing graphs from them. They 
must be added and deleted manually by you. 

Additionally, pages can now be given unique names to identify them. Page names can be used in 
dialogue commands and FAST-TCF, as well as JavaScript and Python scripts for ease of 
automation. 

Note that these above additions are not currently supported by the D3PLOT-T/HIS link, which 
remains limited to 32 graphs at this point in time. 

Also addressed the issue where you found it too easy to accidentally change the layout for all 
pages when you only wanted to change it for your current page by introducing a confirmation 
popup when changing layouts for all pages at once. 

JavaScript API 

• Case 58724 

A new global JavaScript API command THISLinkStatus() has been added to return the status of 
T/HIS in the link. It returns Constant.STANDALONE, Constant.DOCKED, 
Constant.MENUS_UNDOCKED or Constant.ALL_UNDOCKED. 

Text 

• Case 56495 

The contents of the dialogue box can now be saved as text file with a new button Save → Text. 

Workflows 

• Case 57595 

The workflows multiple models selection popup now has all the models selected by default. 
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In addition, two buttons have been added to select and deselect all the models. 

• Case 57232 

A new class method has been added to the Workflow JS-API class, 
Workflow.GetWorkflowDataFromPath() 
 
It searches for workflow data in the specified path and can be used to read Workflow user data 
for models that might have been read in after the workflow was started. 

• Case 57214 

The behaviour of the user_data_required property in the workflow definition file has been 
changed. 

Previously, if this was set to false, then user data would not be read in when running a workflow, 
even if it existed. 

The behaviour has been changed in release 23.0 so that it will be read in if it exists, i.e. setting 
user_data_required: false means user data is optional. 
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3.4 REPORTER 

Pages 

• Case 56933 

From REPORTER 23.0 onwards, reports can be written to a new PowerPoint or appended to an 
existing PowerPoint using a template PowerPoint file. During both these processes, REPORTER 
items are scaled to fit the template PowerPoint layout. 

• Case 56740 

Added the Ctrl+D keyboard shortcut to duplicate a page when selected (and in focus) in page 
navigation. 

Pedestrian 

• Case 56894 

A HIC Processor tool has been added to PRIMER to post-process head impact result data, to 
calculate HIC and generate a .blob file. Inputs can be .lst files (from model build) or existing 
.blob files with partial results. 

PowerPoint 

• Case 57506 

The thumbnails of the Movie (MP4) items written out to PPTX and PDF files can be controlled 
using Movie (MP4) thumbnail frame preferences found under Preferences → Apps. By default, 
this preference is set to Current, meaning the thumbnail will reflect the frame where the Movie 
item is paused. You can also change this setting to First or Last to control which frame is used as 
the thumbnail. 

• Case 56983 

Reports can be saved using an existing PowerPoint template or appended to an existing file. 
Slide layouts are automatically applied, with content scaled to fit. 

Preferences 

• Case 55966 

PRIMER, D3PLOT, T/HIS, and REPORTER can now be configured to exit automatically after a 
specified duration. The timeout is controlled via the OASYS_TIMEOUT environment variable. 
Once the defined limit is reached, the applications terminate safely. 

User Interface 

• Case 53524 

Sorting and search features have now been added to the Variables dialog. 
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• Case 52734 

Search functionality has now been added to the Logfile dialog. 

• Case 50870 

Search functionality has now been added to the Main Window to enable finding relevant actions 
and submenus. 

• Case 42528 

Search functionality has now been added to the Choose a Template and Choose a Page dialogs. 

Workflows 

• Case 56970 

You can now download the template thumbnail via the Edit Template Properties dialog, or via 
the JavaScript/Python API. You can also now update the thumbnail 
with an image of your choice via the API. 
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3.5 Oasys Suite – Cross Application 

Help 

• Case 58048 

New links to the Workflows new features PDF has been added in all programs. 

For PRIMER, D3PLOT, T/HIS and REPORTER, go to Help → What’s New. There are now two 
buttons linked to new features PDFs in the <INSTALL_DIR\manuals\new_feature> directory: 
one for the current program and one for Workflows. 

For SHELL, a new Workflows button was added under Manuals → What’s New. 

Licensing 

• Case 56882 

The optional ‘timeouts’ feature, which will suspend a process if it has been idle for longer than a 
specified time, has historically been controlled by a file called ‘timeouts’ in the OA_ADMIN or 
OA_INSTALL directories. 

The ability to define timeout settings in the LMX licence file, arup.lic, was requested and has 
now been implemented. 

• Case 54632 

From release 22.1 onwards: 

- The optional ‘timeouts’ feature now suspends an interactive session rather than killing it. 

- If you cannot re-acquire a licence and save your work while in this state, the save 
location is now a unique directory identified by date and time, and within that directory 
each model is saved in sub-directories m1, m2, etc. 

In release 23.0, the capability remains the same, but the introduction of a new Licence Manager 
panel makes it easier to understand the current licence and timeout status, and to re-acquire a 
licence. 
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